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INTRODUCTION
With the Data Import Excel Add-in, you can open an existing or new Microsoft Excel
worksheet, map the data, and then import the mapped data to tax form fields in Organizer or
data entry screens in the Tax Accounting System.

The Data Import Excel Add-in enhances the efficiency of data transfer by:

l Decreasing data transfer time.

l Eliminating transcription errors that can occur when manually transferring data.

l Incorporating tools for copying data and mapping schemas from one worksheet to
another in preparation for import.

l Enhancing the control and flexibility of data transfer and management.

l Identifying worksheet errors such as duplications, incorrect codes, and miscalculations
before data is loaded into the Tax Accounting System or Organizer, preventing time-
consuming edits and corrections.

The Data Import Excel Add-in is currently available for 2015 forward for Organizer import.
The Tax Accounting System import for adjustments is available for 2003 forward.
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2 Introduction

Download the Data Import Excel Add-in

DOWNLOAD THE DATA IMPORT EXCEL ADD-IN
To download the Data Import Excel Add-in:

1. In ONESOURCE Income Tax, go to Tools > Download Excel Add-in, and then select
Excel Add-in Downloads.
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Download the Data Import Excel Add-in

2. Select Download for the Excel Add-in appropriate for your version of Office.

3. In the File Download dialog box, select Save and choose a directory where you can
unzip the file.

4. Unzip the file. 

5. Complete the steps in Installation (page 4).
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Installation

INSTALLATION
Complete the following to install the Data Import Excel Add-in:

1. Go to the location where you unzipped the Data Import Excel Add-in, and run setup.exe.

2. If you have an older version of the Data Import Excel Add-in, select Remove Data
Import Excel Add-in, and then select Finish.

If the Data Import Excel Add-in does not allow you to remove the previous
version, open your Control Panel, select Add or Remove Programs, and
manually delete the old Data Import Excel Add-in for Microsoft Excel program.
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Installation

3. In Welcome to the Data Import Excel Add-in Setup Wizard, select Next.
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6 Introduction

Installation

4. In the Select Installation Folder, select Next to install the Data Import Excel Add-in in
the default folder location, or browse to a new save location, and then select Next.
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Installation

5. In Confirm Installation, select Next.
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Installation

6. Wait until the Data Import Excel Add-in is fully installed.
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Register

7. When the Installation Complete appears, select Close.

REGISTER
After installation is complete, you must register the Data Import Excel Add-in before you can
access Add-in mapping and import functions.

For Client Manager Accounts, Administrators must assign permissions to users in
the Administration module before users can register. In Client Assignments, mark
the SYS_FIRM and Child Account for Import client.
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Register

When you open an Excel spreadsheet after successfully installing the Data Import
Excel Add-in, a prompt about registering the Data Import Excel Add-in does not
automatically appear. You must select Register to activate the dialog boxes which
will lead you through the registration process.

1. Open an Excel spreadsheet.

2. Select the Data Import tab, and then select Register.

3. In the Registration screen, type your ONESOURCE Universal ID and Password, and
then select Register. 

You will only be able to register if the password does not contain a space at
the beginning.
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Register

4. The Registering screen appears while the process takes place.

5. Select OK when the Data Import confirmation box appears.
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Register

6. You can also register other licensed products by selecting the Product drop-down in
the Registration box and selecting the appropriate product.

To register a product other than one licensed through ONESOURCE, you must
use the ID and Password credentials provided by that product.

7. After all selected products are registered, select Done.

If the ONESOURCE account associated with your Universal ID and Password
does not include a valid license to use the Data Import add-in for any
products, a warning message appears:
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Administrative Tasks

8. Select the Data Import tab in Excel to access the data mapping, import, and setup
functions.

If you installed the Data Import Excel Add-in but do not have a valid license
the Data Import tab appears on the Excel toolbar, but the Add-in mapping
and import functions are not available.

ADMINISTRATIVE TASKS
Review the sections below about accessing data mapping, importing, and setup. Select Add-
in Info under the new Excel Data Import tab to access information about data mapping,
import, and other administrative tasks.
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Administrative Tasks

LOGINS

Under Add-in Info, select Settings > Login to edit logins.

SINGLE SIGN-ON

Excel Add-in uses the Single Sign-on (SSO) setting from Platform > User Administration >
Setup. Ensure that you have the latest version of the Excel Add-in if you are required to use
SSO to access ONESOURCE Income Tax. You must re-register your product after installation.
If you don't re-register after installation, you will be blocked from sending the workbook using
the Send Active Workbook feature into Income Tax if you are required to use SSO.

ONESOURCE INCOME TAX DATA IMPORT EXCEL ADD-IN VERSION 18.1.1

USER GUIDE V3: SEPTEMBER 5, 2023



Introduction 15

Administrative Tasks

If you attempt to register the Excel Add-in with the ONESOURCE login and password when
you are required to use SSO, you will receive an error message:

If you are a user who is included on the Exemption list, you can continue to register the Excel
Add-in with your ONESOURCE login and password.
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Administrative Tasks

NETWORK URL

To enter the company network URL:

1. Navigate to Addin Info > Settings > Login tab. The Use Single Sign-on option is
automatically checked.

2. Configure your customized Single Sign-on URL for Excel Add-in that was provided by
the SSO team:

a. Double click on the URL field.

b. Enter your customized URL, which includes the Excel Add-in authentication
(highlighted in yellow): https://customizedclientssourl.com
&TargetResource=https://www.onesourcelogin.com/loginping.aspx?ostarget=ss
o/generatetoken.ashx?tokenTimeoutInSeconds=1800

c. Select OK.

Contact Customer SSO at customer.sso@thomsonreuters.com for assistance setting
up the customized SSO URL.
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Administrative Tasks

PROXY

If your company uses a proxy server to access the internet, and your company does not use
Proxy Auto Config (PAC), you must enter proxy settings to successfully transfer data to
ONESOURCE Income Tax.

1. Select Add-in Info > Settings

2. Select the Proxy tab.

3. Select Enabled.

4. Add your company’s proxy server URL Address and Port.

5. Type your user’s domain Username and Password.

6. Select OK.
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Administrative Tasks

CLIENT MANAGER SETUP (USER WITH MULTI-CLIENT
ACCESS)

If you are a user with multi-client access, and want to import into another account, you must
change the Account number in Settings.

1. Select Add-in Info > Settings.

2. Select the Income Tax tab.

3. In the Account box, type the four digit child account number, and then select OK.

The default account is set to the Parent account. All accounts must be
authorized to use the Data Import Excel Add-in.
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Administrative Tasks

DEBUG

The Debug log is used for troubleshooting issues when using the Data Import Excel Add-in.
To access the debug tool, select the Debug tab in Settings. Unless instructed by a support
representative, the Debug Log setting should remain as Off.
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Administrative Tasks

CHECK FOR UPDATES

To check for Data Import Excel Add-in software updates:

1. Select Add-in Info, and then select Check for Updates.

2. If your Data Import Excel Add-in is up-to-date, a message box appears confirming this.
If there is a new Data Import Excel Add-in update available, a dialog box appears
asking you to download the new version.
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BINDER GROUPS
Before using Data Import mapping or import functions, please review the following
information about Binder Groups.

If you previously accessed mapping and import functions through Quick Launch
groups, you must map to Binder Groups to access Data Import functions.

CREATE NEW BINDER GROUP
When creating a new Binder Group to use with Data Import:

l Do not include multiple binders for an entity in the same Binder Group. The Data
Import Excel Add-in cannot differentiate various binders within an entity in a Binder
Group. After the Data Import Excel Add-in sends import data (containing targeted
Binders within the same Entity) to ONESOURCE Income Tax, the Import Log returns an
error with the following explanation:

Unable to determine binder because Binder Group contains multiple binders
with the same targeted Company / Entity number.

l Do not include multiple return types in the same Binder Group. Data Import Excel
Add-in has different maps for different return types (for example, 1120, 1065).
Therefore, if there are different return types within the import file, the Data Import
Excel Add-in sends data into only one return type.
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Previously Mapped Import Files Data Import

PREVIOUSLY MAPPED IMPORT FILES DATA IMPORT
When using a previously mapped import file, follow the steps below prior to importing to
ONESOURCE Income Tax:

1. Select the Data Import tab, and then select Update Maps.

2. In Update Maps, select the appropriate spreadsheet, and then select OK.

3. Open the Source Pane and map the new Identifier for BinderGroup.

4. Validate and send.
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XML MAPS
Review the following topics about creating XML maps.

When you export from ONESOURCE Income Tax, files are saved as .csv. When you
create mapping files to import, you must save the files as .xls or .xlsx in order to
import them successfully. Mapping will not save to a .csv file.
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Map Data on an Existing Worksheet

When you map a workbook, you can no longer use the Microsoft feature Share
Workbook. If you want to share the workbook, you must remove the maps.

MAP DATA ON AN EXISTING WORKSHEET
You can open an existing Excel worksheet, map the data, and then import the mapped data
into ONESOURCE Income Tax.

1. Open an existing Excel worksheet.
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Map Data on an Existing Worksheet

2. Select New Map.

3. Select the Income Tax tab.

If your account is authorized for Income Tax, you also have access to
Estimated Payments.

4. Select the Select box drop-down menu.
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Map Data on an Existing Worksheet

5. Select Tax Accounting System or a Tax Return year.

Tax Accounting System targets are not designation-year specific, so you do
not need to create a map for each TAS year. However, Tax Return targets are
year specific; therefore, you must create a map for each Tax Return year.

Also, when you map elements, both TAS and Tax Return targets require a
Year element mapped by the user. The Year element helps define and find the
ONESOURCE Income Tax binder.

6. If you select Tax Accounting System, select a Tax Accounting System option, select
the Target Schema, and then select OK.
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Map Data on an Existing Worksheet

7. If you select Tax Return, select a tax year, return, and target (form or schedule), and
then select OK.
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Map Data on an Existing Worksheet

8. On the spreadsheet, select the data you want to map on the worksheet.
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Map Data on an Existing Worksheet

9. In the XML Source pane, select twice the corresponding data element.

As an alternative method of mapping, you can drag and drop the XML Source
identifiers to the selected data elements. To Move, Size, or Close the Source
Pane, select the arrow at the top of the pane and select an option.

10. Complete your mapping, and repeat process for subsequent worksheets.

11. Run validation and correct any errors.

Review the following about mappings:

l A yellow box appears around the data to indicate that it is mapped to the selected
value.
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Map New Worksheet

l A heading box appears to the right of the data.

You can either keep an existing title or add a title generated from the XML-
Source pane. See Manage Headings (page 33) for more information about
headings.

l Blue outlines appear around the data after it is mapped.

l The mapped elements are bold in the XML Source pane.

MAP NEW WORKSHEET
To map a new worksheet:

1. Open a new Excel spreadsheet.

2. Enter the new data.

3. Select New Map.

4. Select the Income Tax tab.

5. Follow the steps in Map Data on an Existing Worksheet (page 24) starting with step 4.
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Rename a New Mapping

RENAME A NEW MAPPING
When you select the Target Schema, the Name field in the New Mapping dialog box is
populated with a default name reflecting the selected target (a tax return or tax accounting
system).

When creating a new mapping, you can edit or change the target name in the dialog box.

1. Select New Mapping.

2. In New Mapping, select the target to be renamed.
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The Depth Element

3. Select in the Name field and edit the name or type a new name.

The new name appears in the XML Source Pane.

THE DEPTH ELEMENT
Certain forms require the use of the Depth element when mapping group data. The Depth
element defines the last member in a data group. If a form requires the Depth element, the
element appears in the XML Source pane, designated by _Depth at the end of the element
name.

To use the Depth element when mapping group data:

1. After mapping group data, select the Depth element in the XML Source pane (for
example, AccountNumbers_Depth).
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Manage Headings

2. In the column on the worksheet where the group data is mapped, drag the Depth
element to the row directly below the bottom row of the group data.

See Examples (page 77) for additional information on Group Data Formats.

MANAGE HEADINGS
You can either retain an existing heading on your worksheet, or use the Data Import Excel
Add-in feature to add headings to groupings of data. If you keep an existing heading, it does
not affect the data mapping or importing processes.

If you use XML Source headings, be sure to map to the data and not to an existing heading if
one is already on the spreadsheet.

The Heading Options box provides the option to add headings above the data or to the left of
the data.
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Manage Headings

ADD HEADING TO THE LEFT OF DATA

1. After mapping data on the worksheet, select the heading box to the right of the
mapping indicator lines.

2. Select Place XML Heading to the Left.

If you do not want to lose existing data when placing a header, ensure the
target heading cell is blank or previously mapped.
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Manage Headings

3. If you select Place XML Heading to the Left, and the data to the left of the element
has not been previously mapped, the new heading will replace the existing data.

4. If the data to the left has already been mapped, the Place XML Heading to the Left
option is unavailable and dimmed on the menu. You cannot overwrite the data with a
heading.
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Manage Headings

ADD HEADING ABOVE DATA

1. Map data and select Place XML Heading Above. If there is no heading on the
worksheet, the title from the corresponding XML Source pane element appears.

2. If there is an existing title, it will be replaced by the title from the XML Source pane.
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Identify Mapped Elements

3. There must be a row above the data in order to place headings above the elements.
Otherwise, only the blue lines indicating the data is mapped appear.

Select and drag column borders to expand columns to see complete heading
names.

RETAIN EXISTING HEADINGS

If there are already headings on the worksheet, and you want to keep them, select My Data
Already Has Headings, or simply map the next data selection. If you do not open the
Heading Options box when you map data, and then proceed to map another element, the
Heading Options box closes for the previous element.

IDENTIFY MAPPED ELEMENTS
You can open a spreadsheet you have mapped previously and verify which elements your
data is mapped to. This could be particularly helpful if you have kept your worksheet
headings instead of applying the XML Source pane headings.

To identify how element data is mapped:

1. Open a mapped worksheet.

2. Blue lines appear around mapped data.

3. Select within the boundary of a blue line.
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Global Identifiers Map

4. The element to which it is mapped is highlighted in the XML Source pane.

GLOBAL IDENTIFIERS MAP
If you have multiple worksheets within a workbook that have the same identifiers (Year,
Company Number, Entity, and so forth) in the same configuration, you can use Global
Identifier to map the identifiers for all worksheets at one time.

1. In a workbook, open the sheet you want to map with global identifiers.

2. Select Global Identifiers, and then select Income Tax.
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Copy Mapping

3. Using the Income Tax - Global Identity in the XML Source pane, map the identifier
elements. All worksheets in the workbook are mapped to the same global identifiers.

If an individual worksheet within a workbook is already mapped with other
identifiers, the global identifiers will not overwrite the elements already mapped.
That worksheet retains the initial mapping schema.

COPY MAPPING
If you have multiple worksheets with the same data formats, you can copy the mapped
element selections from one worksheet to another instead of mapping each worksheet
individually.

All worksheets must have the same data configuration and the same mapping
target. For example, you can only copy mapped elements on a Schedule D
worksheet to another Schedule D worksheet.
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Copy Mapping

To copy mapping configuration from one worksheet to another:

1. Open a mapped worksheet.
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Copy Mapping

2. Select Copy Mapping, and then select Worksheet.

3. If you want to copy a different worksheet in your workbook, select the drop-down in
Source Sheet, and then select that worksheet.
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Copy Mapping

4. In the Map(s) Selection box, select the Source maps or mapped schemas to copy.

5. In the Destination(s) Selection box, select the Destination sheets to copy.
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Copy Mapping

6. If you select a specific mapped schema from your source map, the mapping schema is
copied to the Destination sheet.
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Copy Mapped Elements to Workbooks

7. If you select all maps from your source map, the mapping schema is copied—but not
the data. If there is existing data on the second worksheet, it is then mapped to the
same elements as the first sheet, or you can add new data.

COPY MAPPED ELEMENTS TO WORKBOOKS
If you have multiple workbooks with the same data format, and tab names in the target
workbooks match those in the original workbook, you can copy the mapped element
selections from one workbook to another instead of mapping each workbook individually.
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Copy Mapped Elements to Workbooks

To copy mapped elements from one workbook to another:

1. Open a mapped Excel workbook.

2. Select Copy Mapping > Workbook > By Worksheet Order or By Worksheet Name.
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Copy Mapped Elements to Workbooks

3. In Select target workbooks, browse to and select the workbook you want to copy the
data to.

4. Select Open.
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Delete an XML Map in Excel

5. The selected workbook opens, and its existing data elements are mapped with the
same schema as the first workbook.

DELETE AN XML MAP IN EXCEL
To delete an existing XML map:

1. In the XML Source, select XML Maps.
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Auto Update Feature for Existing Maps

2. Select the workbook maps to delete, and then select Delete.

3. When the warning box appears, select OK to continue with the deletion.

AUTO UPDATE FEATURE FOR EXISTING MAPS
If you have a workbook containing targets from a previous release that have had new fields
exposed, you can use the Map Version feature to automatically update the targets,
eliminating the need to re-map the workbooks to reflect those changes.

There are two options to trigger the update.
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Auto Update Feature for Existing Maps

OPTION 1

1. Open the previously mapped worksheet that contains the old version of the map.

2. Select Update Maps to see a list of all maps in the worksheet.

3. Note the update status of Yes or No in the Current column.

4. If the status is No, and you want to update the maps, select Update.
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Auto Update Feature for Existing Maps

5. Select OK to update all maps in the current workbook.

6. The maps for all sheets in the workbook are updated and the new fields appear in the
Source pane.

You can select the Update Maps option at any time to review or select
versions of a mapped file.

OPTION 2

1. Open the previously mapped worksheet that contains the old version of the map.

2. Select Validate Data.

3. If there are no errors, a validation message appears. Select OK.
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Roll Over Mapping

4. The maps for all sheets in the workbook are updated and the new fields appear in the
Source pane.

ROLL OVER MAPPING
You can rollover worksheet mapping from one year to the next without having to add a new
current year map (and remap all existing cells).

We recommend that you create a backup copy of the workbook prior to performing
these steps.

To rollover mapping configuration from one year to another:

1. Open a mapped worksheet.
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Roll Over Mapping

2. Change the data in the Year Identifier cell to the year after the current year (for
example, if the current year is 2016, change to 2017).

3. Select Update Maps.
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Roll Over Mapping

4. On Update Maps, select OK.

5. When the warning message appears, select OK. The worksheet mapping is updated
with elements for the new year.
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Roll Over Mapping

6. Although it is not required, we recommend that you rename the rolled-over target map
to reflect the new year. To rename the worksheet map name, select Source Pane.

7. In the XML Source pane, select XML Maps.

8. Select the map name and select Rename.
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Mapping Tips

9. Rename the map, and then select OK.

MAPPING TIPS
Use the following tips to ensure a successful transfer of mapped data into ONESOURCE
Income Tax.

IDENTIFIERS

It is extremely important that you include identifiers with the data being mapped on a
worksheet. These identifiers are required for an import into ONESOURCE Income Tax.
Identifiers are marked with red asterisk in the schema XML Source pane.

l If Binder Group is used as an identifier, you must include a CompanyNumber and
Year, and they must be mapped. You can include more than one entity, but there can
be only one binder per entity.

l If the Binder Name is used as an identifier, the Consolidated Entity or Entity name
must be included, and they must be mapped. You can include multiple binders per
entity; however, additional identifiers could be required.
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Mapping Tips

JOURNAL ENTRIES

Journal entries must balance. Journal entries must match exactly on the worksheets, and
match to the input criteria designated by the import location in ONESOURCE Income Tax.
The following are examples of journal entry errors that could prevent the transfer of data
from a worksheet to ONESOURCE Income Tax.

l Incorrect Text Type (For example, data is entered as text when it should be numeric.)

l Incorrect Codes (For example, a journal entry type or form code is incorrect.)

l Matches Not Found (For example, within a Binder Group in Excel, a company number
is not found in the corresponding Binder Group in ONESOURCE Income tax.)

l Duplicate Numbers (For example, company numbers are found in more than one
binder.)

DATA FORMAT

Data must be in a columnar format. An exception is in Adjustments, where the company
identifier (entity name, company number) must be entered horizontally across the top of the
rest of the data.

EXPAND NUMERICAL COLUMNS

Before transferring a worksheet to ONESOURCE Income Tax, you must expand columns with
numerical data until the data can be seen in its entirety.
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Mapping Tips

EXTRA/BLANK MAPS

Extra/blank maps can cause a Could Not Load Target message during validation.

Verify that your workbook has no extra/blank maps.

1. Select XML Maps in the XML Source pane.

2. Select to highlight the extra/blank map.

3. Select Delete, and then select OK.

4. Select OK to close the window.
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Mapping Tips
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TEMPLATES
The Templates download contains mapped worksheets of all released Data Import Excel
Add-in import targets. Tax Return Templates are available by tax type (1120 and 1065) and
year (2014 -2016). There is also a template for Tax Accounting System.

Each Tax Return and Tax Accounting System Excel workbook contains a mapped target on
separate worksheets. You can use the mapped worksheets for import or copy.
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To download the Templates:

1. In ONESOURCE Income Tax, navigate to Tools > ONESOURCE Tools > Download
Excel Add-in > Download Templates.

2. On the Download Templates screen, select Download.

3. In the File Download dialog box, select Open and select templates to save, or select
Save to save the template .zip file.

4. After saving, browse to save location to access the templates.
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VALIDATE WORKSHEETS
The following sections explain verification and sample import errors.

VERIFY WORKSHEET INPUT FOR IMPORT
To validate a worksheet before importing it to ONESOURCE Income Tax:

1. Open the mapped worksheet.

2. Select Validate Data.

3. If the worksheet is ready to import to ONESOURCE Income Tax, a confirmation
message appears.
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Sample Import Errors

4. If there are errors on the worksheet, an Errors list appears. Correct the errors, and then
select Validate again.

All organizer targets must have an entry for the Year Identifier element (for
example, 2014, 2015). If a year does not exist, the target fails validation with
an error: Could not load target.

SAMPLE IMPORT ERRORS
Various types of errors can prevent a worksheet from being imported into ONESOURCE
Income Tax. Sample validation errors include:

l Incorrect Text Type (For example, data is entered as text when it should be numeric.)

l Incorrect Codes (For example, a journal entry type or form code is incorrect.)

See Mapping Tips (page 55) for additional information about preventing import errors.

The Validation feature might not catch all import errors. After transferring data to
ONESOURCE Income Tax, always check the Import Log for Status to verify the
import was completed. Also, open the ONESOURCE Income Tax target area and
verify data was imported properly.
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IMPORTS
After a worksheet or workbook is mapped and validated, you can transfer the data to
ONESOURCE Income Tax.

This section includes the following topics about importing data into Income Tax:

Import Data into ONESOURCE Income Tax 65
Successful Imports 68
Unsuccessful Imports 68

Verify Imports in ONESOURCE Income Tax 69
Verify Organizer Imports 69
Verify Adjustment Imports 69

Import Troubleshooting 70
Problem 1: Missing Data in Binder 70
Problem 2: Unable to Determine a Binder from the Identity 71
Import Log Usage 72

IMPORT DATA INTO ONESOURCE INCOME TAX
To import the data from a mapped worksheet into ONESOURCE Income Tax:

1. Open the worksheet.

2. Select the bottom half of the Send Active Workbook button.
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Import Data into ONESOURCE Income Tax

3. Select one of the following options:

l Send Active Workbook (sends the workbook currently open)

l Send Multiple Workbooks

4. If you select Send Active Workbook, select OK on the confirmation.

5. If you select Send Multiple Workbooks, do the following in the Select workbooks to
send:

l Browse to location of the workbooks to send to ONESOURCE Income Tax.

l Select workbooks, and then select Open.

ONESOURCE INCOME TAX DATA IMPORT EXCEL ADD-IN VERSION 18.1.1

USER GUIDE V3: SEPTEMBER 5, 2023



Imports 67

Import Data into ONESOURCE Income Tax

6. Complete the steps in one of the following based on your results:

l Successful Imports (page 68)

l Unsuccessful Imports (page 68)

To access previous versions of workbooks, select the drop-down Open, and then
select Show previous versions.

A list of previous version Workbooks and modification dates opens in the Select
workbooks to send dialog box.
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Import Data into ONESOURCE Income Tax

SUCCESSFUL IMPORTS

1. If the transfer to ONESOURCE Income Tax is successful, select OK on the confirmation
message.

2. To validate the transfer, open the Import Log. The status of the transfer is indicated in
the Status column. If the transfer was successful, the log will designate the status as
Complete.

3. If the transfer status is Complete, go to ONESOURCE Income Tax to verify that the
information was imported to the correct place and is in the correct format.

UNSUCCESSFUL IMPORTS

1. If there is a problem importing the data to ONESOURCE Income Tax, select OK on the
message Validation errors exist.

2. Correct the errors on the Errors list.

3. After the corrections are made, start the import process again.
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Verify Imports in ONESOURCE Income Tax

If your import fails because of a login problem, verify the following:

l In Add-In Settings, the account number, user name, and password entered
match the ONESOURCE Income Tax credentials you use to log in.

l The ONESOURCE Income Tax credentials you have supplied has rights to
import into the binder to which you are sending data.

l If your company has a proxy in place, and your company does not use Proxy
Auto Config (PAC), verify the proxy settings on the Add-In Info Settings
dialog box are correct (this information comes from your IT department).

VERIFY IMPORTS IN ONESOURCE INCOME TAX
For organizer imports, you can view the binder history within ONESOURCE Income Tax to
verify an import. For adjustments, use Audit Trail inside the binder to verify the import.

VERIFY ORGANIZER IMPORTS

1. Open ONESOURCE Income Tax.

2. Select the binder to which the data was imported.

3. In the left menu, select History to see the Organizer History.

VERIFY ADJUSTMENT IMPORTS

1. Open ONESOURCE Income Tax.

2. Open the binder to which the data was imported.

3. On the Tax Accounting System tree, select Audit Trail.

4. For Data Type, select Adjustments.

5. Select the various adjustment types to be verified.

6. Clear the box Show only records where the amount changed.
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Import Troubleshooting

7. Select Run Query.

You can filter queries by using dates, user names, and adjustment types.

IMPORT TROUBLESHOOTING
If you have problems with your import, see if you have one of the two common issues below,
or you can follow the instructions in Import Log Usage (page 72).

PROBLEM 1: MISSING DATA IN BINDER

If Excel says your import was sent, but you do not see the data in your binder, verify the map
you are using is for the correct return type. For example:

l Form 4562 maps exist for both 1120 and 1065 returns but are not interchangeable. The
1120 Form 4562 map only imports to 1120 return types and the 1065 Form 4562 only
imports to 1065 return types.

l Partnership maps contain the letter P in the name. Form 4562 for 1065 return types is
called IRSP4562 and for 1120 return types it is IRS4562.

Partnership 1065 return type

Corporate 1120 return type
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Import Troubleshooting

PROBLEM 2: UNABLE TO DETERMINE A BINDER FROM THE
IDENTITY

If you receive the import error Unable to Determine a Binder from the Identity, review the
following:

l The year, company number, entity name, or binder name is incorrect or does not exist in
ONESOURCE Income Tax.

l The binder has been created in ONESOURCE Income Tax, but it has not been opened or
computed.

l The binder is not part of the BinderGroup or the Consolidated Entity in batch import.
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Import Troubleshooting

IMPORT LOG USAGE

The Import Log provides information on the status and history of imports.

Review the Log

1. To open the Import Log, go to Tools > ONESOURCE Tools > GLM and Excel Add-in
Import Log.
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Import Troubleshooting

2. Review the Status column to determine what happened during the import. Here are
some common Status types:

l Complete

l Received

l Processing

l Queued

l Error

3. If you see a Received, Processing, or Queued status, check back at a later time for the
final status. If you see an Error status, the transfer to ONESOURCE Income Tax was not
successful. Correct the errors and try the import again.

To see more information about the import status, including error information,
select anywhere in the line of an import, and additional information opens
below the line.
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Import Troubleshooting

4. To navigate back and forth between log pages, select Previous or Next, or select a
specific page number in the boxes at the bottom of the screen.

.

Filter Error Reports

You can filter the import criteria to produce a more data-specific report.

To filter data in the Import Log:

1. On the Import Log screen, select Filter Log.
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Import Troubleshooting

2. Enter filter criteria (for example, User, Year, Company, Binder, Entity, Quick Launch,
and Status. You can choose one field or a combination of criteria fields. Generally, the
more criteria fields you filter, the narrower the search results.

If you want to select a Status as a filter, select the Status drop-down, and
select an option on the list.

3. After you enter criteria, select Filter.

4. The filtered report appears on the Import Log screen.
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Import Troubleshooting

5. To remove defined criteria and return to an unfiltered report, select Clear Filter.

Download the Import Log

You can generate a file that contains all of the results in the Import Log, or a specific report
you create using filter criteria.

To create a Microsoft Office Excel Comma Separated Value (.csv) file of the Import Log:

1. On the Import Log screen, select Export.

2. In File Download, select Open, and then select Save and browse to the save location.

Delete the Import Log

To delete all the results in the Import log:

1. On the Import Log screen, select Delete.

2. Select OK on the warning message to continue the deletion.

We recommend that you export and save the Import Log prior to deleting all
the import results.
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Group Data Format

EXAMPLES
The following are selected use cases.

Group Data Format 77
Multi-Level Group Data Format 78
Multi-Company/Group Data Format for Tax Accounting System Targets 79
Multi-Company/Group Data Format for Tax Return Targets 80

Form 1065 81
Form 1120 81

Tax Accounting System (TAX) Intercompany Targets 82
1165/1120 Tax Return Targets 84

GROUP DATA FORMAT
You must format group data for 1120 and 1065 Tax Return targets in rows. Map a group’s
individual Data elements as column headings, with its Depth element defining the last row of
Organizer import data. The sample below shows group data for the 1120 Officer
Compensation Tax Return target.
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Multi-Level Group Data Format

MULTI-LEVEL GROUP DATA FORMAT
The following 1120 Tax Return targets contain multi-level group data (group data within
another group):

l Disposition Detail

l Schedule D Detail Form 5472

l Form 5713 (Schedules A and B only)

l Form 8621

As previously stated, all Tax Return group data must be formatted in rows. In order to
maintain the alignment of group data within a group, the inside Organizer group data must
be completed (last row) before a new outside group is started (new row of the outside group).
The result is all inside group detail will be imported into the outside group of the previous row
of the outside group.

The sample below shows multi-level group data for the 1120 Disposition Detail target. The
group detail ComputationOfGainScheduleDetail (inside group) is part of DispositionDetail
(outside group). Successfully importing this sample data would result in the following:

l ComputationOfGainScheduleDetail1of1, ComputationOfGainScheduleDetail2of1,
and ComputationOfGainScheduleDetail3of1 will be included within the
6252Property1 group.

l ComputationOfGainScheduleDetail1of2 and ComputationOfGainScheduleDetail2of2
will be included within the 6252Property2 group.

l ComputationOfGainScheduleDetail1of3, ComputationOfGainScheduleDetail2of3,
and ComputationOfGainScheduleDetail3of3 will be included within the
6252Property3 group.
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Multi-Company/Group Data Format for Tax Accounting System Targets

MULTI-COMPANY/GROUP DATA FORMAT FOR TAX
ACCOUNTING SYSTEM TARGETS
The Tax Accounting System targets listed below have multi-company import capability. You
can use the BinderGroup or ConsolidatedEntity Identifiers for this type of import.

With the BinderGroup, you can import to any Binder or Binders in the corresponding Binder
Group in ONESOURCE Income Tax. With the ConsolidatedEntity, you can import to any
Member or Members of a Top Consolidation, Sub Consolidation, or Divisional
Consolidation.

Multi-company import targets have two elements called CompanyNumbers and
CompanyNumbers_End that (once mapped) define the Binders/Members of a BinderGroup
or Consolidated Entity.

l Adjustments

l Binder Properties Member’s List

l CFC Asset Sourcing

l CFCFTC Income Sourcing

l Insurance Workpaper - Schedule F and G
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Multi-Company/Group Data Format for Tax Return Targets

l Preliminary Balances

l Preliminary Balances with Activity Information

l Prior Year DAC-Unamortized at Beginning of Year

l State A & A

l State Tax Expense

l State Tax Payments

l State TI - Modifications and Apportioned Inc Adj

l Schedule M2

The sample below shows how to import several Adjustments to three separate binders of a
Quick Launch Group called Excel Add-in3.

MULTI-COMPANY/GROUP DATA FORMAT FOR TAX
RETURN TARGETS
The Tax Return targets listed below have multi-company import capability. You can use the
BinderGroup or ConsolidatedEntity Identifiers for this type of import.

With the BinderGroup, you can import to any Binder or Binders in the corresponding Binder
Group in ONESOURCE Income Tax. With the ConsolidatedEntity, you can import to any
Member or Members of a Top Consolidation, Sub Consolidation, or Divisional Consolidation.
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Multi-Company/Group Data Format for Tax Return Targets

Multi-company import targets have two elements called CompanyNumbers and
CompanyNumbers_End that (once mapped) define the Binders/Members of a BinderGroup
or ConsolidatedEntity.

FORM 1065

Federal

l Capital Gains and Losses

l Form 4562

l Partner Information

l Sales of Bus Prop and Gains and Losses with Section 179 Exp

l Form 8975 Part II

l Form 8975 Schedule A Parts I, II, III

FORM 1120

Federal

l Disposition Detail (Forms 4797, 6252, 4684)

l Form 4562

l Form 4626

l Form 4797 Overrides

l Form 8883

l Officer Compensation

l Reference ID Numbers for 5471, 8858, and 8865

l Schedule D Detail
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Tax Accounting System (TAX) Intercompany Targets

l Form 8865 Schedules A, A-1, and A-2

l Withholding for Foreign Persons

l Form 851 Part II Voting Stock Information

l Form 8975 Part II

l Form 8975 Schedule A Parts I, II, III

l Form 8082

State

l 4562 Overrides – Adopts Expanded 179

l 4562 Overrides – Non Adopting

l A & A Detail, Other Adjustments, and Credits

l Common State Bank Info-Authorization to Debit Funds

l Illinois State Adjustments – Additions and Subtractions

l State & City ID Numbers

l Texas Combined Return Information

l New York Investment and Other Exempt Income and Investment Capital

l New York State Adjustments

TAX ACCOUNTING SYSTEM (TAX) INTERCOMPANY
TARGETS
You can use all of the International targets (Dividends, Interest, Rent, and Royalties) to
map intercompany payments and receipts for a given type of transaction. For example, you
can map intercompany payments and receipts for dividends using the CFC Intercompany
Dividends target.
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Tax Accounting System (TAX) Intercompany Targets

However, each row of mapped data must be either a payment or a receipt. A validation error
is generated if this condition is not met. You cannot transmit the mapped data to
ONESOURCE Income Tax until the error is corrected.

The import target entity company number is determined programmatically. If a
RecipientAmount is entered, the RecipientEntityCompanyNumber is used to determine the
import target entity. If a PayorAmount is entered, the PayorEntityCompanyNumber is used
to determine the import target entity.

If you use BinderGroup or ConsolidatedEntity and BinderName in the Identifiers section,
you can include intercompany payments or receipts for multiple binders on one Excel
worksheet.

Worksheets can contain data for intercompany payments or intercompany receipts, or both,
for a single company or multiple companies. An entire row must be valid for the row to import
(no partial import permitted). Invalid recipient entities (where entity type equals Division or
Eliminations) will be logged as error.

Delete any existing data for the selected binder for the transaction and look-through type
being imported. Sending an import without valid rows will delete any existing data for that
transaction and look-through type.

XML submitted to Web Service does not need to contain data designated as default; for
example, the Related Other Expenses for an Intercompany Receipts – Interest import, or
the Spot Rate to US$ for Pre ’87 DPC or PTI Exchange G/L for Intercompany Payments –
Dividends import.

Duplicate entries between a payer-recipient pair are allowed. For example, if you are
importing to Company A, you can have multiple receipts of the same transaction and look-
through type from Company B.

Valid rows of data will import. Invalid rows of data will not import. For example, if you have
two interest intercompany payments from two different companies, and the data from the
first company validates but the data from the second company does not, the data from the
first company will import. The data from the second company will not import. Send
comprehensive, user-friendly messaging to the second company about the errors. Provide
feedback for each of the items within the row being rejected, not just the first error
encountered.
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1165/1120 Tax Return Targets

1165/1120 TAX RETURN TARGETS
A worksheet previously mapped with a 1120 Tax Return target (for example, Form 4562,
Schedule D Overrides) cannot be used for a 1065 Tax Return target (and vice versa). For
example, individually mapped cells of a worksheet (that is, New Mapping defined as Tax
Return > 2015 > 1120 > Federal > Form 1120) only correspond to Organizer fields in the
1120 Tax Application.

You cannot simply change the Identifiers data to that of a 1065 binder and successfully
import to fields in the 1065 Tax Application. A new 1065 Tax Return Target must be
defined and mapped.
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APPENDIX - AVAILABLE IMPORT
TARGETS

TAX ACCOUNTING SYSTEM

Import Target Import Path

Adjustments Tax Accounting System > Adjustments

Binder Properties
Members’ List

Binder Properties > Members tab

CFC Asset Sourcing Tax Accounting System > Foreign Entity > Asset Sourcing

CFC Intercompany
Dividends

Foreign Entity > Look-Thru Transactions > Intercompany Payments or
Intercompany Receipts

CFC Intercompany
Interest

Foreign Entity > Look-Thru Transactions > Intercompany Payments or
Intercompany Receipts

CFC Intercompany
Rent

Foreign Entity > Look-Thru Transactions > Intercompany Payments or
Intercompany Receipts

CFC Intercompany
Royalties

Foreign Entity > Look-Thru Transactions > Intercompany Payments or
Intercompany Receipts

CFCFTC Income
Sourcing

Tax Accounting System > Foreign Entity or Foreign Tax Credit > Income
Sourcing

Insurance Workpaper
- Schedule F and G

Tax Accounting System > Insurance Workpaper (Schedule F and G tabs)

Preliminary Balances Tax Accounting System > Balances

Preliminary Balances
with Activity
Information

Tax Accounting System > Balances
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Corporate

Import Target Import Path

Prior Year DAC-
Unamortized at
Beginning of Year

Tax Accounting System > Insurance Workpapers > Prior Year DAC tab

Schedule M2 Tax Accounting System > Schedule M-2

Schedule M-3 Part II
Detail (lines 1-12)

Tax Accounting System > Schedule M-3

State A & A Tax Account System > State Workpapers > Data Entry > State A&A >
Corporate Entity (excluding Partnerships) > Property, Payroll, Sales,
Allocation, or All State A&A

State Tax Expense Tax Accounting System > State Workpapers > Data Entry > Taxable Income
and Taxes > Tax Expense

State Tax Payments Tax Accounting System > Tax Payments

State TI –
Modifications and
Apportioned Inc Adj

Tax Accounting System > State Workpapers > Data Entry > Taxable Income
and Taxes > Modifications and Apportioned Income Adjustments

CORPORATE

FEDERAL

Import Target Years Avail-
able

Import Path

Disposition Detail
(Forms 4797, 4684
and 6252)

2019, 2020,
2021

Gains and Losses > Disposition of Property > Disposition
Detail

Form 114 2019, 2020,
2021

Foreign Information > Foreign Bank Account
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Corporate

Import Target Years Avail-
able

Import Path

Form 4562 2019, 2020,
2021

Income and Deductions > Deductions > Depreciation and
Amortization > General Depreciation and Amortization >
Form 4562 Information > 4562 Overrides

Form 4797
Overrides

2019, 2020,
2021

Gains and Losses > Compute and Print Options > Summary
Overrides

Form 5471,
Schedule A

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule A {note: xxx is Foreign
Corporation Name specified by import/user}

Form 5471,
Schedule B

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule B {note: xxx is Foreign
Corporation Name specified by import/user}

Form 5471,
Schedule M

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule M {note: xxx is Foreign
Corporation Name specified by import/user}

Form 5471,
Schedule O, Part I

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part I {note: xxx
is Foreign Corporation Name specified by import/user}

Form 5471,
Schedule O, Part II
Section A

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
A {note: xxx is Foreign Corporation Name specified by
import/user}

Form 5471,
Schedule O, Part II
Section B

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
B {note: xxx is Foreign Corporation Name specified by
import/user}

Form 5471,
Schedule O, Part II
Section C

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
C {note: xxx is Foreign Corporation Name specified by
import/user}
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Corporate

Import Target Years Avail-
able

Import Path

Form 5471,
Schedule O, Part II
Section D

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
D {note: xxx is Foreign Corporation Name specified by
import/user}

Form 5471,
Schedule O, Part II
Section E

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
E {note: xxx is Foreign Corporation Name specified by
import/user}

Form 5471,
Schedule O, Part II
Section F

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > Schedule O > Schedule O, Part II, Section
F {note: xxx is Foreign Corporation Name specified by
import/user}

Form 5472 2019, 2020,
2021

Foreign Information > 25% Foreign Owned Corporation > xxx
> Mandatory Entry – Related Party and Foreign Information >
25% Foreign Owned Corporation > xxx > Monetary
Transactions {note: xxx is Foreign Corporation Name specified
by import/user}

Form 5713 2019, 2020,
2021

Foreign Information > International Boycott Report >
International Boycott Report Information

Form 5884 2019, 2020,
2021

Credits > Work Opportunity Credit

Form 6765 2019, 2020,
2021

Credits > Credit for Increasing Research > Credit for
Increasing Research

Form 7004 2019, 2020,
2021

Payments and Extension > Automatic Extensions > 7004
Basic Data > and the two group screens “Subsidiary – No
Transfer” and “Inactive Subsidiaries”

Form 8082 2019, 2020,
2021

Information Forms > Inconsistent Treatment > General
Information
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Corporate

Import Target Years Avail-
able

Import Path

Form 851 2019, 2020,
2021

Informational Forms > Affiliation Schedule > 851

Form 851 Multi-
tiered
Consolidations

2019, 2020,
2021

Informational Forms > Affiliation Schedule > Multi-tiered
Consolidations

Form 851 Part II
Voting Stock
Information

2019, 2020,
2021

Informational Forms > Affiliation Schedule > Part II Enter on
the sub (Multi-tier)

Form 8594 2019, 2020,
2021

Informational Forms > Asset Acquisition

Form 8621 2019, 2020,
2021

Foreign Information > PFIC and QEF

Form 8824 2019, 2020,
2021

Gains and Losses > Like - Kind Exchanges

Form 8858 Books
and Records

2019, 2020,
2021

Foreign Information > FDE and FB > Foreign Disregarded
Entity > xxx > Books and Records {note: xxx is Foreign
Disregarded Entity Name specified by import/ user}

Form 8858 Direct
Owner of FDE

2019, 2020,
2021

Foreign Information > FDE and FB > Foreign Disregarded
Entity > xxx > Direct Owner of FDE {note: xxx is Foreign
Disregarded Entity Name specified by import/ user}

Form 8858 Filer
Information

2019, 2020,
2021

Foreign Information > FDE and FB > Foreign Disregarded
Entity > xxx > Filer Information {note: xxx is Foreign
Disregarded Entity Name specified by import/ user}

Form 8858 General
Information

2019, 2020,
2021

Foreign Information > FDE and FB > Foreign Disregarded
Entity > xxx > General Information (General Information,
Branch Office or Agent in the US, and Tax Owner of FDE tabs)
{note: xxx is Foreign Disregarded Entity Name specified by
import/ user}
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Corporate

Import Target Years Avail-
able

Import Path

Form 8858
Organization Chart

2019, 2020,
2021

Foreign Information > FDE and FB > Foreign Disregarded
Entity > xxx > Organization Chart {note: xxx is Foreign
Disregarded Entity Name specified by import/user}

Form 8858
Schedule M

2019, 2020,
2021

Foreign Information > FDE and FB > xxx > Schedule M {note:
xxx is Foreign Disregarded Entity Name specified by
import/user}

Form 8865
Schedule N

2019, 2020,
2021

Foreign Information > Foreign Partnership > xxx > Foreign
Partnership Information > Foreign Partnership Transactions
{note: xxx is Foreign Corporation Name specified by
import/user}

Form 8865
Schedules A, A-1,
and A-2

2019, 2020,
2021

Foreign Information > Foreign Partnership > xxx > Foreign
Partnership Information > Constructive Ownership of
PtrshipInt, Certain Partners of Foreign Partnership, and
Affiliation Schedule {note: xxx is Foreign Partnership Name
specified by import/user}

Form 8883 2019, 2020,
2021

Information Forms > Asset Allocation Statement

Form 8903 2018, 2019,
2020

Income and Deductions > Deductions > Domestic Production
Activities Ded

Form 8975 Part II 2019, 2020,
2021

Foreign Information > Country-by-Country Reporting >
Country-by-Country Report

Form 8975
Schedule A Parts I,
II, III

2019, 2020,
2021

Foreign Information > Country-by-Country Reporting > Tax
Jurisdiction and Constituent Entity Info

NOTE: You can import Organizer data for all screens within
the Tax Jurisdiction and Constituent Info folder except for the
"Identification number type description" (which is in the
Additional Identification Numbers folder).

Officer
Compensation

2019, 2020,
2021

Income and Deductions > Deductions > Officers’
Compensation > Individual Officers
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Corporate

Import Target Years Avail-
able

Import Path

Pass-Through
Entity for Ordinary
Activity Type

2019, 2020,
2021

Income and Deductions > Pass-Through Entity > Pass-
Through Entity

Reference ID
Numbers for 5471,
8858, and 8865

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign
Corporation > xxx > General Information or Foreign
Information > Foreign Disregarded Entity > General
Information or Foreign Information > Foreign Partnership Info
> General Information

Schedule D Detail 2019, 2020,
2021

Gains and Losses > Capital Gains and Losses > Capital Assets
Sales Detail

Schedule D
Overrides

2019, 2020,
2021

Gains and Losses > Compute and Print Options > Summary
Overrides

Schedule K 2019, 2020,
2021

General Information > Questions > Schedule K

Schedule M-2 2019, 2020,
2021

Balance Sheet/M1-M2-M3 > Schedule M1 /M2 > Ret. Earnings
(M-2) tab

Schedule M-3, Part
I

2019, 2020,
2021

Balance Sheet/M1-M2-M3 > Schedule M-3 > Sch M-3, Part I
tab

Schedule N 2019, 2020,
2021

General Information > Miscellaneous Information > Schedule
N

Schedule O 2019, 2020,
2021

Taxes > Consent Plan and Apportionment Sch

Taxes > Group Member Information

Uncertain Tax
Position

2019, 2020,
2021

General Information > Questions > Schedule UTP

Withholding for
Foreign Persons

2019, 2020,
2021

Informational Forms > Withholding for Foreign Persons >
Withholding for Foreign Persons
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Corporate

STATES

Import Target Years
Available

Import Path

4562 Overrides -
Adopts Expanding
179

2019, 2020,
2021

Income and Deductions > Deductions > Depreciation and
Amortization > General Depreciation and Amortization >
Form 4562 Information > 4562 Overrides > State - Adopts
Expanding 179 tab

4562 Overrides - Non
Adopting

2019, 2020,
2021

Income and Deductions > Deductions > Depreciation and
Amortization > General Depreciation and Amortization >
Form 4562 Information > 4562 Overrides > State - Non
Adopting tab

A&A Detail, Other
Adjustments, and
Credits

2019, 2020,
2021

States > Alaska > State Adjustments > Dividend Received
Deduction tab or California > Allocation & Apportionment >
Allocation & Apportionment or Mississippi > Allocation &
Apportionment or Nebraska > Credits

Alabama Intangible
and Interest Exp Add
Back

2019, 2020,
2021

States > Alabama > Intangible/Interest Expense Add Back

Allocation Data Entry 2019, 2020,
2021

States > Allocation and Apportionment > Data Entry >
Allocation Data Entry > Dividend, Interest, Rents, Royalties,
Capital Gain and Loss, Sales of Assets, Other

Common State: Bank
Info-Authorization to
Debit Funds

2019, 2020,
2021

States > Common State > General Information > Bank
Information > Direct Debit tab

General Information 2019, 2020,
2021

States > Common State > General Information > Basic
Return Information, various tabs

Illinois State
Adjustments –
Additions and
Subtractions

2019, 2020,
2021

States > Illinois > State Adjustments > Additions and
Subtractions

States > Illinois > State Adjustments > Special Depreciation
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Corporate

Import Target Years
Available

Import Path

Installment Payments
for Next Years
Estimated Tax

2019, 2020,
2021

Common State > Estimates and Extensions > Estimate
options > Overrides

Miscellaneous
Dividend Information

2019, 2020,
2021

States > IL or IN or NE or NJ or CA > state specific Dividend
Organizer or Tax Form screen

Miscellaneous State
Information

2019, 2020,
2021

States > Common State > General Information > Paid
Preparer Information

States > Common State > General Information > Books and
Records

New York A & A -
MCT Overrides

2019, 2020,
2021

States > Allocation and Apportionment >
Organizer/Overrides > New York > Property - MCT (and
Payroll and Sales - MCT)

New York Investment
and Other Exempt
Income and
Investment Capital

2019, 2020,
2021

States > New York > Exempt Income and Capital

New York State
Adjustments

2019, 2020,
2021

States > New York > State Adjustments

NOL Carryover from
Prior Year

2019, 2020,
2021

States > Common State > State NOL Tracking > click State
link

Other State & City
Information

2019, 2020,
2021

States > CT, IL, MI, NY, NYC, NY Bank, OH, WV > state
specific Organizer input

Other Tax Base &
Franchise
Information

2019, 2020,
2021

States > MI Financial, AL Privilege Tax, LA, MS, NC > state
specific Organizer input

Pennsylvania
Depreciation
Adjustments

2019, 2020,
2021

States > Pennsylvania > State Adjustments > Depreciation
Adjustments
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Corporate - Homeowners Association (1120H)

Import Target Years
Available

Import Path

State & City Numbers 2019, 2020,
2021

States > Common State > General Information > State/City
ID Numbers

Texas Combined
Return Information

2019, 2020,
2021

State Franchise Tax > Texas Franchise > Combined Return
Information

CITY

Import Target Years Avail-
able

Import Path

New York City A & A
Overrides

2019, 2020,
2021

States > Allocation and Apportionment > Organizer /
Overrides > New York City

CORPORATE - HOMEOWNERS ASSOCIATION (1120H)

FEDERAL

Import Target Years Available Import Path

Other Info – Homeowners
Assoc

2019, 2020, 2021 Income and Deductions > Other Info –
Homeowners Associations
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Partnership

PARTNERSHIP

FEDERAL

Import Target Years
Available

Import Path

Capital Gains and
Losses

2019, 2020,
2021

Gains and Losses > Capital Gains and Losses > Gains
Distributions, Stocks, and Bonds

Form 114 2019, 2020,
2021

Foreign Information > Foreign Bank Account

Form 4562 2019, 2020,
2021

Ordinary Income and Deductions > Depreciation and
Amortization > xxx > 4562 Information > 4562 Overrides {note:
xxx is the name of the Entity and is not generated by the import}

Form 4562 Farm
Activity

2019, 2020,
2021

Activity Information > Farm > xxx > Depreciation and
Amortization > 4562 Information > 4562 Overrides {note: xxx is
the Farm name specified by import/user}

Form 4562
Multiple Trade or
Business Activity

2019, 2020,
2021

Activity Information > Multiple Trade or Business > xxx
>Depreciation and Amortization > 4562 Information > 4562
Overrides {note: xxx is the Multiple Trade or Business name
specified by import/user}

Form 4562 Other
Rental Activity

2019, 2020,
2021

Activity Information > Other Rental > xxx > Depreciation and
Amortization > 4562 Information > 4562 Overrides {note: xxx is
the Other Rental name specified by import/user}

Form 4562 Pass
Through Activity

2019, 2020,
2021

Activity Information > Pass Through Entity > xxx > Depreciation
and Amortization > 4562 Information > 4562 Overrides {note:
xxx is the Pass Through Entity name specified by import/user}

Form 4562 Rental
Activity

2019, 2020,
2021

Activity Information > Rental Real Estate > xxx > Depreciation
and Amortization > 4562 Information > 4562 Overrides {note:
xxx is the Rental Real Estate name specified by import/user}

Form 4797
Overrides

2019, 2020,
2021

Gains and Losses > Summary Overrides
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Partnership

Import Target Years
Available

Import Path

Form 5471
Schedule A

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule A

Form 5471
Schedule B

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule B

Form 5471
Schedule M

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule M

Form 5471
Schedule O, Part I

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O, Part I

Form 5471
Schedule O, Part
II Section A

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IIA

Form 5471
Schedule O, Part
II Section B

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IIB

Form 5471
Schedule O, Part
II Section C

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IIC

Form 5471
Schedule O, Part
II Section D

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IID

Form 5471
Schedule O, Part
II Section E

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IIE

Form 5471
Schedule O, Part
II Section F

2019, 2020,
2021

Foreign Information > Foreign Corporation > Foreign Corporate
Name > Schedule O > Schedule O, Part IIF

Form 5884 2019, 2020,
2021

Credits > Work Opportunity Credit
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Partnership

Import Target Years
Available

Import Path

Form 8621 2019, 2020,
2021

Foreign Information > PFIC or QEF

Form 8975 Part II 2019, 2020,
2021

Foreign Information > Country-by-Country Reporting > Country-
by-Country Report

Form 8975
Schedule A Parts
I, II, III

2019, 2020,
2021

Foreign Information > Country-by-Country Reporting > Tax
Jurisdiction and Constituent Info

NOTE: You can import Organizer data for all screens within the
Tax Jurisdiction and Constituent Info folder except for the
"Identification number type description" (which is in the
Additional Identification Numbers folder).

Partner
Information

2019, 2020,
2021

Partner Information > Partner by Partner Data > Partner Name
(Partner Information tab)

Sales of Bus Prop
and Gains and
Losses with
Section 179 Exp

2019, 2020,
2021

Gains and Losses > Sales of Business Property > Property
Descriptions

Schedule B 2019, 2020,
2021

General Information > Questions and hyperlinks

Schedule D
Overrides

2019, 2020,
2021

Gains and Losses > Summary Overrides

Schedule K 2019, 2020,
2021

Sch K > we import into each of the various screens under Sch K
folder

Schedule M-2 2019, 2020,
2021

Balance Sheet and Reconciliation > Sch M-2

Schedule M-3,
Part I

2019, 2020,
2021

Balance Sheet and Reconciliation > Sch C, Sch M-3 and Form
8916-A > Sch C, Sch M-3 and Form 8916-A > Sch M-3, Part I tab
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Partnership

STATE

Import Target Years
Available

Import Path

Schedule K 2019, 2020, 2021 States > Common State > State Schedule K
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APPENDIX - DATA SPECIFICATIONS
To access the spreadsheet Data Import Excel Add-in Input Data Specifications for Worksheets
Imported into ONESOURCE, please go to Customer Center:

https://tax.thomsonreuters.com/support/onesource/customer-center/

You can access this spreadsheet as a separate Excel document.
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APPENDIX - INCOME TAX RETURN
FOREIGN COUNTRY CODES

Country Codes Code

Afghanistan AF

Akrotiri AX

Albania AL

Algeria AG

American Samoa AQ

Andorra AN

Angola AO

Anguilla AV

Antarctica AY

Antigua and Barbuda AC

Argentina AR

Armenia AM

Aruba AA

Ashmore and Cartier Islands AT

Australia AS

Austria AU

Azerbaijan AJ

Bahamas BF
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Country Codes Code

Bahrain BA

Baker Island FQ

Bangladesh BG

Barbados BB

Belarus BO

Belgium BE

Belize BH

Benin BN

Bermuda BD

Bhutan BT

Bolivia BL

Bosnia-Herzegovina BK

Botswana BC

Bouvet Island BV

Brazil BR

British Indian Ocean Territory IO

British Virgin Islands VI

Brunei BX

Bulgaria BU

Burkina Faso UV

Burma BM
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Country Codes Code

Burundi BY

Cambodia CB

Cameroon CM

Canada CA

Cape Verde CV

Cayman Islands CJ

Central African Republic CT

Chad CD

Chile CI

China CH

Christmas Island KT

Clipperton Island IP

Cocos (Keeling) Islands CK

Colombia CO

Comoros CN

Congo (Brazzaville) CF

Congo (Kinshasa) CG

Cook Islands CW

Coral Sea Islands CR

Costa Rica CS

Cote D'Ivoire (Ivory Coast) IV
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Country Codes Code

Croatia HR

Cuba CU

Curacao UC

Cyprus CY

Czech Republic EZ

Denmark DA

Dhekelia DX

Djibouti DJ

Dominica DO

Dominican Republic DR

East Timor TT

Ecuador EC

Egypt EG

El Salvador ES

Equatorial Guinea EK

Eritrea ER

Estonia EN

Ethiopia ET

Falkland Islands (Islas Malvinas) FK

Faroe Islands FO

Federated States of Micronesia FM
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Country Codes Code

Fiji FJ

Finland FI

France FR

French Polynesia FP

French Southern and Antarctic Lands FS

Gabon GB

The Gambia GA

Georgia GG

Germany GM

Ghana GH

Gibraltar GI

Greece GR

Greenland GL

Grenada GJ

Guam GQ

Guatemala GT

Guernsey GK

Guinea GV

Guinea-Bissau PU

Guyana GY

Haiti HA
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Country Codes Code

Heard Island and McDonald Islands HM

Holy See VT

Honduras HO

Hong Kong HK

Howland Island HQ

Hungary HU

Iceland IC

India IN

Indonesia ID

Iran IR

Iraq IZ

Ireland EI

Israel IS

Italy IT

Jamaica JM

Jan Mayen JN

Japan JA

Jarvis Island DQ

Jersey JE

Johnston Atoll JQ

Jordan JO
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Country Codes Code

Kazakhstan KZ

Kenya KE

Kingman Reef KQ

Kiribati KR

Korea, Democratic People's Republic of (North) KN

Korea, Republic of (South) KS

Kosovo KV

Kuwait KU

Kyrgyzstan KG

Laos LA

Latvia LG

Lebanon LE

Lesotho LT

Liberia LI

Libya LY

Liechtenstein LS

Lithuania LH

Luxembourg LU

Macau MC

Macedonia MK

Madagascar MA
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Country Codes Code

Malawi MI

Malaysia MY

Maldives MV

Mali ML

Malta MT

Man, Isle of IM

Marshall Islands RM

Mauritania MR

Mauritius MP

Mexico MX

Midway Islands MQ

Moldova MD

Monaco MN

Mongolia MG

Montenegro MJ

Montserrat MH

Morocco MO

Mozambique MZ

Namibia WA

Nauru NR

Navassa Island BQ
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Country Codes Code

Nepal NP

Netherlands NL

New Caledonia NC

New Zealand NZ

Nicaragua NU

Niger NG

Nigeria NI

Niue NE

Norfolk Island NF

Northern Mariana Islands CQ

Norway NO

Oman MU

Other Country OC

Pakistan PK

Palau PS

Palmyra Atoll LQ

Panama PM

Papua-New Guinea PP

Paracel Islands PF

Paraguay PA

Peru PE
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Country Codes Code

Philippines RP

Pitcairn Islands PC

Poland PL

Portugal PO

Puerto Rico RQ

Qatar QA

Romania RO

Russia RS

Rwanda RW

Saint Barthelemy TB

Saint Martin RN

Samoa WS

San Marino SM

Sao Tome and Principe TP

Saudi Arabia SA

Senegal SG

Serbia RI

Seychelles SE

Sierra Leone SL

Singapore SN

Sint Maarten NN
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Country Codes Code

Slovakia LO

Slovenia SI

Solomon Islands BP

Somalia SO

South Africa SF

South Georgia and the South Sandwich Islands SX

South Sudan OD

Spain SP

Spratly Islands PG

Sri Lanka CE

St. Helena SH

St. Kitts and Nevis SC

St. Lucia Island ST

St. Pierre and Miquelon SB

St. Vincent and the Grenadines VC

Sudan SU

Suriname NS

Svalbard SV

Swaziland WZ

Sweden SW

Switzerland SZ
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Country Codes Code

Syria SY

Taiwan TW

Tajikistan TI

Tanzania TZ

Thailand TH

Togo TO

Tokelau TL

Tonga TN

Trinidad and Tobago TD

Tunisia TS

Turkey TU

Turkmenistan TX

Turks and Caicos Islands TK

Tuvalu TV

Uganda UG

Ukraine UP

United Arab Emirates AE

United Kingdom (England, Northern Ireland, Scotland, and Wales) UK

Uruguay UY

Uzbekistan UZ

Vanuatu NH
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Country Codes Code

Venezuela VE

Vietnam VM

Virgin Islands VQ

Wake Island WQ

Wallis and Futuna WF

Western Sahara WI

Yemen (Aden) YM

Zambia ZA

Zimbabwe ZI

Financial Crimes Enforcement Network (FinCEN) Form 114 Foreign Country Codes

***Does not apply to General Information | Country of Issue; Financial Institution's
country in Parts II, III, IV & V.

Foreign Country Code

AFGHANISTAN AF

ÅLAND ISLANDS AX

ALBANIA AL

ALGERIA DZ

AMERICAN SAMOA AS

ANDORRA AD

ANGOLA AO

ANGUILLA AI
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Foreign Country Code

ANTARCTICA AQ

ANTIGUA AND BARBUDA AG

ARGENTINA AR

ARMENIA AM

ARUBA AW

AUSTRALIA AU

AUSTRIA AT

AZERBAIJAN AZ

BAHAMAS BS

BAHRAIN BH

BANGLADESH BD

BARBADOS BB

BELARUS BY

BELGIUM BE

BELIZE BZ

BENIN BJ

BERMUDA BM

BHUTAN BT

BOLIVIA, PLURINATIONAL STATE OF BO

BONAIRE, SINT EUSTATIUS AND SABA BQ

BOSNIA AND HERZEGOVINA BA
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Foreign Country Code

BOTSWANA BW

BOUVET ISLAND BV

BRAZIL BR

BRITISH INDIAN OCEAN TERRITORY IO

BRUNEI DARUSSALAM BN

BULGARIA BG

BURKINA FASO BF

BURUNDI BI

CAMBODIA KH

CAMEROON CM

CANADA CA

CAPE VERDE CV

CAYMAN ISLANDS KY

CENTRAL AFRICAN REPUBLIC CF

CHAD TD

CHILE CL

CHINA CN

CHRISTMAS ISLAND CX

COCOS (KEELING) ISLANDS CC

COLOMBIA CO

COMOROS KM
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Foreign Country Code

CONGO CG

CONGO, THE DEMOCRATIC REPUBLIC OF THE CD

COOK ISLANDS CK

COSTA RICA CR

CÔTE D'IVOIRE CI

CROATIA HR

CUBA CU

CURAÇAO CW

CYPRUS CY

CZECH REPUBLIC CZ

DENMARK DK

DJIBOUTI DJ

DOMINICA DM

DOMINICAN REPUBLIC DO

ECUADOR EC

EGYPT EG

EL SALVADOR SV

EQUATORIAL GUINEA GQ

ERITREA ER

ESTONIA EE

ETHIOPIA ET
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Foreign Country Code

FALKLAND ISLANDS (MALVINAS) FK

FAROE ISLANDS FO

FIJI FJ

FINLAND FI

FRANCE FR

FRENCH GUIANA GF

FRENCH POLYNESIA PF

FRENCH SOUTHERN TERRITORIES TF

GABON GA

GAMBIA GM

GEORGIA GE

GERMANY DE

GHANA GH

GIBRALTAR GI

GREECE GR

GREENLAND GL

GRENADA GD

GUADELOUPE GP

GUAM GU

GUATEMALA GT

GUERNSEY GG
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Foreign Country Code

GUINEA GN

GUINEA-BISSAU GW

GUYANA GY

HAITI HT

HEARD ISLAND AND MCDONALD ISLANDS HM

HOLY SEE (VATICAN CITY STATE) VA

HONDURAS HN

HONG KONG HK

HUNGARY HU

ICELAND IS

INDIA IN

INDONESIA ID

IRAN, ISLAMIC REPUBLIC OF IR

IRAQ IQ

IRELAND IE

ISLE OF MAN IM

ISRAEL IL

ITALY IT

JAMAICA JM

JAPAN JP

JERSEY JE
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Foreign Country Code

JORDAN JO

KAZAKHSTAN KZ

KENYA KE

KIRIBATI KI

KOREA, DEMOCRATIC PEOPLE'S REPUBLIC OF KP

KOREA, REPUBLIC OF KR

KUWAIT KW

KYRGYZSTAN KG

LAO PEOPLE'S DEMOCRATIC REPUBLIC LA

LATVIA LV

LEBANON LB

LESOTHO LS

LIBERIA LR

LIBYA LY

LIECHTENSTEIN LI

LITHUANIA LT

LUXEMBOURG LU

MACAO MO

MACEDONIA, THE FORMER YUGOSLAV REPUBLIC OF MK

MADAGASCAR MG

MALAWI MW
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Foreign Country Code

MALAYSIA MY

MALDIVES MV

MALI ML

MALTA MT

MARSHALL ISLANDS MH

MARTINIQUE MQ

MAURITANIA MR

MAURITIUS MU

MAYOTTE YT

MEXICO MX

MICRONESIA, FEDERATED STATES OF FM

MOLDOVA, REPUBLIC OF MD

MONACO MC

MONGOLIA MN

MONTENEGRO ME

MONTSERRAT MS

MOROCCO MA

MOZAMBIQUE MZ

MYANMAR MM

NAMIBIA NA

NAURU NR
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Foreign Country Code

NEPAL NP

NETHERLANDS NL

NEW CALEDONIA NC

NEW ZEALAND NZ

NICARAGUA NI

NIGER NE

NIGERIA NG

NIUE NU

NORFOLK ISLAND NF

NORTHERN MARIANA ISLANDS MP

NORWAY NO

OMAN OM

PAKISTAN PK

PALAU PW

PALESTINE, STATE OF PS

PANAMA PA

PAPUA NEW GUINEA PG

PARAGUAY PY

PERU PE

PHILIPPINES PH

PITCAIRN PN
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Foreign Country Code

POLAND PL

PORTUGAL PT

PUERTO RICO PR

QATAR QA

RÉUNION RE

ROMANIA RO

RUSSIAN FEDERATION RU

RWANDA RW

SAINT BARTHÉLEMY BL

SAINT HELENA, ASCENSION AND TRISTAN DA CUNHA SH

SAINT KITTS AND NEVIS KN

SAINT LUCIA LC

SAINT MARTIN (FRENCH PART) MF

SAINT PIERRE AND MIQUELON PM

SAINT VINCENT AND THE GRENADINES VC

SAMOA WS

SAN MARINO SM

SAO TOME AND PRINCIPE ST

SAUDI ARABIA SA

SENEGAL SN

SERBIA RS
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Foreign Country Code

SEYCHELLES SC

SIERRA LEONE SL

SINGAPORE SG

SINT MAARTEN (DUTCH PART) SX

SLOVAKIA SK

SLOVENIA SI

SOLOMON ISLANDS SB

SOMALIA SO

SOUTH AFRICA ZA

SOUTH GEORGIA AND THE SOUTH SANDWICH ISLANDS GS

SOUTH SUDAN SS

SPAIN ES

SRI LANKA LK

SUDAN SD

SURINAME SR

SVALBARD AND JAN MAYEN SJ

SWAZILAND SZ

SWEDEN SE

SWITZERLAND CH

SYRIAN ARAB REPUBLIC SY

TAIWAN, PROVINCE OF CHINA TW
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Foreign Country Code

TAJIKISTAN TJ

TANZANIA, UNITED REPUBLIC OF TZ

THAILAND TH

TIMOR-LESTE TL

TOGO TG

TOKELAU TK

TONGA TO

TRINIDAD AND TOBAGO TT

TUNISIA TN

TURKEY TR

TURKMENISTAN TM

TURKS AND CAICOS ISLANDS TC

TUVALU TV

UGANDA UG

UKRAINE UA

UNITED ARAB EMIRATES AE

UNITED KINGDOM GB

UNITED STATES ***(see note) US *** (see note)

UNITED STATES MINOR OUTLYING ISLANDS UM

URUGUAY UY

UZBEKISTAN UZ
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Foreign Country Code

VANUATU VU

VENEZUELA, BOLIVARIAN REPUBLIC OF VE

VIET NAM VN

VIRGIN ISLANDS, BRITISH VG

VIRGIN ISLANDS, U.S. VI

WALLIS AND FUTUNA WF

WESTERN SAHARA EH

YEMEN YE

ZAMBIA ZM

ZIMBABWE ZW

Financial Crimes Enforcement Network (FinCEN) FORM 115 Canadian Province Codes

Province Code

Alberta AB

British Columbia BC

Manitoba MB

New Brunswick NB

Newfoundland and Labrador NL

Northwest Territories NT

Nova Scotia NS

Nunavut NU

Ontario ON
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Province Code

Prince Edward Island PE

Québec QC

Saskatchewan SK

Yukon YT

Financial Crimes Enforcement Network (FinCEN) FORM 114 Mexican State Codes

State Code

Aguascalientes AGU

Baja California BCN

Baja California Sur BCS

Campeche CAM

Coahuila COA

Colima COL

Chiapas CHP

Chihuahua CHH

Distrito Federal DIF

Durango DUR

Guanajuato GUA

Guerrero GRO

Hidalgo HID

Jalisco JAL

Mexico MEX
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State Code

Michoacán MIC

Morelos MOR

Nayarit NAY

Nuevo León NLE

Oaxaca OAX

Puebla PUE

Querétaro QUE

Quintana Roo ROO

San Luis Potosí SLP

Sinaloa SIN

Sonora SON

Tabasco TAB

Tamaulipas TAM

Tlaxcala TLA

Veracruz VER

Yucatán YUC

Zacatecas ZAC
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APPENDIX - INCOME TAX RETURN
FOREIGN CURRENCY CODES

Currency Codes Code

ADB Unit of Account - MEMBER COUNTRIES OF THE AFRICAN DEVELOPMENT BANK
GROUP

XUA

Afghani - AFGHANISTAN AFN

Algerian Dinar - ALGERIA DZD

Argentine Peso - ARGENTINA ARS

Armenian Dram - ARMENIA AMD

Aruban Florin - ARUBA AWG

Australian Dollar - AUSTRALIA, CHRISTMAS ISLAND, COCOS (KEELING) ISLANDS (THE),
HEARD ISLAND AND McDONALD ISLANDS, KIRIBATI, NAURU, NORFOLK ISLAND,
TUVALU

AUD

Azerbaijan Manat - AZERBAIJAN AZN

Bahamian Dollar - BAHAMAS (THE) BSD

Bahraini Dinar - BAHRAIN BHD

Baht - THAILAND THB

Balboa - PANAMA PAB

Barbados Dollar - BARBADOS BBD

Belarusian Ruble - BELARUS BYN

Belize Dollar - BELIZE BZD

Bermudian Dollar - BERMUDA BMD

Bolivar Soberano - VENEZUELA (BOLIVARIAN REPUBLIC OF) VES
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Currency Codes Code

Boliviano - BOLIVIA (PLURINATIONAL STATE OF) BOB

Brazilian Real - BRAZIL BRL

Brunei Dollar - BRUNEI DARUSSALAM BND

Bulgarian Lev - BULGARIA BGN

Burundi Franc - BURUNDI BIF

Cabo Verde Escudo - CABO VERDE CVE

Canadian Dollar - CANADA CAD

Cayman Islands Dollar - CAYMAN ISLANDS (THE) KYD

CFA Franc BCEAO - BENIN, BURKINA FASO, COTE D'IVOIRE, GUINEA-BISSAU, MALI,
NIGER (THE), SENEGAL, TOGO

XOF

CFA Franc BEAC - CAMEROON, CENTRAL AFRICAN REPUBLIC (THE), CHAD, CONGO
(THE), EQUATORIAL GUINEA, GABON

XAF

CFP Franc - FRENCH POLYNESIA, NEW CALEDONIA, WALLIS AND FUTUNA XPF

Chilean Peso - CHILE CLP

Colombian Peso - COLOMBIA COP

Comorian Franc- COMOROS (THE) KMF

Congolese Franc - CONGO (THE DEMOCRATIC REPUBLIC OF THE) CDF

Convertible Mark - BOSNIA AND HERZEGOVINA BAM

Cordoba Oro - NICARAGUA NIO

Costa Rican Colon - COSTA RICA CRC

Cuban Peso - CUBA CUP

Czech Koruna - CZECHIA CZK
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Currency Codes Code

Dalasi - GAMBIA (THE) GMD

Danish Krone - DENMARK, FAROE ISLANDS (THE), GREENLAND DKK

Denar - MACEDONIA (THE FORMER YUGOSLAV REPUBLIC OF) MKD

Djibouti Franc - DJIBOUTI DJF

Dobra - SAO TOME AND PRINCIPE STN

Dominican Peso - DOMINICAN REPUBLIC (THE) DOP

Dong - VIET NAM VND

East Caribbean Dollar - ANGUILLA, ANTIGUA AND BARBUDA, DOMINICA, GRENADA,
MONTSERRAT, SAINT KITTS AND NEVIS, SAINT LUCIA, SAINT VINCENT AND THE
GRENADINES

XCD

Egyptian Pound - EGYPT EGP

El Salvador Colon - EL SALVADOR SVC

Ethiopian Birr - ETHIOPIA ETB

Euro - ALAND ISLANDS, ANDORRA, AUSTRIA, BELGIUM, CYPRUS, ESTONIA,
EUROPEAN UNION, FINLAND, FRANCE, FRENCH GUIANA, FRENCH SOUTHERN
TERRITORIES (THE), GERMANY, GREECE, GUADELOUPE, HOLY SEE (THE), IRELAND,
ITALY, LATVIA, LITHUANIA, LUXEMBOURG, MALTA, MARTINIQUE, MAYOTTE,
MONACO, MONTENEGRO, NETHERLANDS (THE), PORTUGAL, REUNION, SAINT
BARTHELEMY, SAINT MARTIN (FRENCH PART), SAINT PIERRE AND MIQUELON, SAN
MARINO, SLOVAKIA, SLOVENIA, SPAIN

EUR

Falkland Islands Pound - FALKLAND ISLANDS (THE) [MALVINAS] FKP

Fiji Dollar - FIJI FJD

Forint - HUNGARY HUF

Ghana Cedi - GHANA GHS

Gibraltar Pound - GIBRALTAR GIP
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Currency Codes Code

Gourde - HAITI HTG

Guarani - PARAGUAY PYG

Guinean Franc - GUINEA GNF

Guyana Dollar - GUYANA GYD

Hong Kong Dollar - HONG KONG HKD

Hryvnia - UKRAINE UAH

Iceland Krona - ICELAND ISK

Indian Rupee - BHUTAN, INDIA INR

Iranian Rial - IRAN (ISLAMIC REPUBLIC OF) IRR

Iraqi Dinar - IRAQ IQD

Jamaican Dollar - JAMAICA JMD

Jordanian Dinar - JORDAN JOD

Kenyan Shilling - KENYA KES

Kina - PAPUA NEW GUINEA PGK

Kuna - CROATIA HRK

Kuwaiti Dinar - KUWAIT KWD

Kwanza - ANGOLA AOA

Kyat - MYANMAR MMK

Lao Kip - LAO PEOPLE’S DEMOCRATIC REPUBLIC (THE) LAK

Lari - GEORGIA GEL

Lebanese Pound - LEBANON LBP
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Currency Codes Code

Lek - ALBANIA ALL

Lempira - HONDURAS HNL

Leone - SIERRA LEONE SLL

Liberian Dollar - LIBERIA LRD

Libyan Dinar - LIBYA LYD

Lilangeni - ESWATINI SZL

Loti - LESOTHO LSL

Malagasy Ariary - MADAGASCAR MGA

Malawi Kwacha - MALAWI MWK

Malaysian Ringgit - MALAYSIA MYR

Mauritius Rupee - MAURITIUS MUR

Mexican Peso - MEXICO MXN

Mexican Unidad de Inversion (UDI) - MEXICO MXV

Moldovan Leu - MOLDOVA (THE REPUBLIC OF) MDL

Moroccan Dirham - MOROCCO, WESTERN SAHARA MAD

Mozambique Metical - MOZAMBIQUE MZN

Mvdol - BOLIVIA (PLURINATIONAL STATE OF) BOV

Naira - NIGERIA NGN

Nakfa - ERITREA ERN

Namibia Dollar - NAMIBIA NAD

Nepalese Rupee - NEPAL NPR
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Currency Codes Code

Netherlands Antillean Guilder - CURACAO, SINT MAARTEN (DUTCH PART) ANG

New Israeli Sheqel - ISRAEL ILS

New Taiwan Dollar - TAIWAN (PROVINCE OF CHINA) TWD

New Zealand Dollar - COOK ISLANDS (THE), NEW ZEALAND, NIUE , PITCAIRN,
TOKELAU

NZD

Ngultrum - BHUTAN BTN

North Korean Won - KOREA (THE DEMOCRATIC PEOPLE’S REPUBLIC OF) KPW

Norwegian Krone - BOUVET ISLAND, NORWAY, SVALBARD AND JAN MAYEN NOK

Ouguiya - MAURITANIA MRU

Pa'anga - TONGA TOP

Pakistan Rupee - PAKISTAN PKR

Pataca - MACAO MOP

Peso Convertible - CUBA CUC

Peso Uruguayo - URUGUAY UYU

Philippine Peso - PHILIPPINES (THE) PHP

Pound Sterling - GUERNSEY, ISLE OF MAN, JERSEY, UNITED KINGDOM OF GREAT
BRITAIN AND NORTHERN IRELAND (THE)

GBP

Pula - BOTSWANA BWP

Qatari Rial - QATAR QAR

Quetzal - GUATEMALA GTQ

Rand - LESOTHO, NAMIBIA, SOUTH AFRICA ZAR

Rial Omani - OMAN OMR
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Currency Codes Code

Riel - CAMBODIA KHR

Romanian Leu - ROMANIA RON

Rufiyaa - MALDIVES MVR

Rupiah - INDONESIA IDR

Russian Ruble - RUSSIAN FEDERATION (THE) RUB

Rwanda Franc - RWANDA RWF

Saint Helena Pound - SAINT HELENA, ASCENSION AND TRISTAN DA CUNHA SHP

Saudi Riyal - SAUDI ARABIA SAR

SDR (Special Drawing Right) - INTERNATIONAL MONETARY FUND (IMF) XDR

Serbian Dinar - SERBIA RSD

Seychelles Rupee - SEYCHELLES SCR

Singapore Dollar - SINGAPORE SGD

Sol - PERU PEN

Solomon Islands Dollar - SOLOMON ISLANDS SBD

Som - KYRGYZSTAN KGS

Somali Shilling - SOMALIA SOS

Somoni - TAJIKISTAN TJS

South Sudanese Pound - SOUTH SUDAN SSP

Sri Lanka Rupee - SRI LANKA LKR

Sucre - SISTEMA UNITARIO DE COMPENSACION REGIONAL DE PAGOS "SUCRE" XSU

Sudanese Pound - SUDAN (THE) SDG
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Currency Codes Code

Surinam Dollar - SURINAME SRD

Swedish Krona - SWEDEN SEK

Swiss Franc - LIECHTENSTEIN, SWITZERLAND CHF

Syrian Pound - SYRIAN ARAB REPUBLIC SYP

Taka - BANGLADESH BDT

Tala - SAMOA WST

Tanzanian Shilling - TANZANIA, UNITED REPUBLIC OF TZS

Tenge - KAZAKHSTAN KZT

Trinidad and Tobago Dollar - TRINIDAD AND TOBAGO TTD

Tugrik - MONGOLIA MNT

Tunisian Dinar - TUNISIA TND

Turkish Lira - TURKEY TRY

Turkmenistan New Manat - TURKMENISTAN TMT

UAE Dirham - UNITED ARAB EMIRATES (THE) AED

Uganda Shilling - UGANDA UGX

Unidad de Fomento - CHILE CLF

Unidad de Valor Real - COLOMBIA COU

Unidad Previsional - URUGUAY UYW

Uruguay Peso en Unidades Indexadas (UI) - URUGUAY UYI
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Currency Codes Code

US Dollar - AMERICAN SAMOA, BONAIRE, SINT EUSTATIUS AND SABA, BRITISH
INDIAN OCEAN TERRITORY (THE), ECUADOR, EL SALVADOR, GUAM, HAITI,
MARSHALL ISLANDS (THE), MICRONESIA (FEDERATED STATES OF), NORTHERN
MARIANA ISLANDS (THE), PALAU, PANAMA, PUERTO RICO, TIMOR-LESTE, TURKS
AND CAICOS ISLANDS (THE), UNITED STATES MINOR OUTLYING ISLANDS (THE),
UNITED STATES OF AMERICA (THE), VIRGIN ISLANDS (BRITISH), VIRGIN ISLANDS
(U.S.)

USD

US Dollar (Next day) - UNITED STATES OF AMERICA (THE) USN

Uzbekistan Sum - UZBEKISTAN UZS

Vatu - VANUATU VUV

WIR Euro - SWITZERLAND CHE

WIR Franc - SWITZERLAND CHW

Won - KOREA (THE REPUBLIC OF) KRW

Yemeni Rial - YEMEN YER

Yen - JAPAN JPY

Yuan Renminbi - CHINA CNY

Zambian Kwacha - ZAMBIA ZMW

Zimbabwe Dollar - ZIMBABWE ZWL

Zloty - POLAND PLN
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APPENDIX - OFFICER TITLE CODES
Officer Title Code

President / CEO President

Sr. Vice President SRVP

Vice President V.P.

Assistant Vice President AVP

Actuary Actuary

CEO CEO

CFO CFO

COO COO

CSO CSO

Clerk Clerk

Chairman Chairman

Comptroller Comptroller

Assistant Comptroller AComptroller

Controller Controller

Director Director

General Counsel Genl Counsel

Officer Officer

Secretary Secretary

Assistant Secretary ASecretary

Treasurer Treasurer
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Officer Title Code

Assistant Treasurer ATreasurer

Other Other
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APPENDIX - LATE FILING REASON CODES
Late Filing Reason Code

Forgot to file 1

Did not know I had to file 2

Thought account balance was below reporting threshold 3

Did not know my account qualified as foreign 4

Account statement not received in time 5

Account statement lost (replacement requested) 6

Late receiving missing required account information 7

Unable to obtain joint spouse signature in time 8

Unable to access BSA E-Filing System 9

Other 999
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APPENDIX - FOREIGN PERSONS
CHAPTER 3 STATUS CODES

Name Code

U.S. Withholding Agent – FI 01

U.S. Withholding Agent – Other 02

Territory FI treated as U.S. Person 03

U.S. branch of Participating FFI – treated as U.S. Person 05

U.S. branch of Participating FFI – not treated as U.S. Person  06

U.S. branch - ECI presumption applied  07 

Partnership other than Withholding Foreign Partnership 08

Withholding Foreign Partnership 09

Trust other than Withholding Foreign Trust 10

Withholding Foreign Trust 11

Qualified Intermediary 12

Qualified Securities Lender – Qualified Intermediary 13

Qualified Securities Lender – Other 14

Corporation 15

Individual 16

Estate 17

Private Foundation 18

Government or International Organization 19

Tax Exempt Organization (Section 501(c) entities) 20
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Name Code

Unknown Recipient 21

Artist or Athlete 22

Pension 23

Foreign Central Bank of Issue 24

Nonqualified Intermediary 25

Hybrid entity making Treaty Claim 26

Withholding Rate Pool – General 27

Withholding Rate Pool – Exempt Organization 28

PAI Withholding Rate Pool – General 29

PAI Withholding Rate Pool – Exempt Organization 30

Agency Withholding Rate Pool – General 31

Agency Withholding Rate Pool – Exempt Organization 32

U.S. Withholding Agent-Foreign branch Fl 34

Qualified Derivatives Dealer 35
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APPENDIX - FOREIGN PERSONS
CHAPTER 4 STATUS CODES

Name Code

U.S. Withholding Agent – FI 01

U.S. Withholding Agent – Other 02

Territory FI –not treated as U.S. Person 03

Territory FI – treated as U.S. Person 04

Participating FFI – Other 05

Participating FFI – Reporting Model 2 FFI 06

Registered Deemed-Compliant FFI – Reporting Model 1 FFI 07

Registered Deemed-Compliant FFI – Sponsored Entity 08

Registered Deemed-Compliant FFI – Other 09

Certified Deemed-Compliant FFI – Other 10

Certified Deemed-Compliant FFI – FFI with Low Value Accounts 11

Certified Deemed-Compliant FFI – Non-Registering Local Bank 12

Certified Deemed-Compliant FFI – Sponsored Entity 13

Certified Deemed-Compliant FFI – Investment Entity that does not maintain financial
accounts

14

Nonparticipating FFI 15

Owner-Documented FFI 16

U.S. Branch-treated as U.S. person 17

U.S. Branch-not treated as U.S. person (reporting under section 1471) 18
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Name Code

Passive NFFE identifying Substantial U.S. Owners 19

Passive NFFE with no Substantial U.S. Owners 20

Publicly Traded NFFE or Affiliate of Publicly Traded NFFE 21

Active NFFE 22

Individual 23

Section 501(c) Entities 24

Excepted Territory NFFE 25

Excepted NFFE - Other 26

Exempt Beneficial Owner 27

Entity Wholly Owned By Exempt Beneficial Owners 28

Unknown Recipient 29

Recalcitrant Account Holder 30

Nonreporting IGA FFI 31

Direct reporting NFFE 32

U.S. reportable account 33

Non–consenting U.S. account 34

Sponsored direct reporting NFFE 35

Excepted Inter-affiliate FFI 36

Undocumented Preexisting Obligation 37

US branch – ECI presumption applied 38

Account Holder of Excluded Financial Account 39
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Name Code

Passive NFFE reported by FFI 40

NFFE Subject to 1472 withholding 41

Recalcitrant Pool – No U.S. Indicia 42

Recalcitrant Pool – U.S. Indicia 43

Recalcitrant Pool – Dormant Account 44

Recalcitrant Pool – U.S. Persons 45

Recalcitrant Pool – Passive NFFEs 46

Nonparticipating FFI Pool 47

U.S. Payees Pool 48

QI-Recalcitrant Pool-General 49

U.S. Withholding Agent-Foreign branch of Fl 50
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APPENDIX - FORM 8975 ACTIVITY CODES
Activity Code

CBC501 - Research and Development CBC501

CBC502 - Holding or Managing Intellectual Property CBC502

CBC503 - Purchasing or Procurement CBC503

CBC504 - Manufacturing or Production CBC504

CBC505 - Sales, Marketing, or Distribution CBC505

CBC506 - Administrative, Management, Or Support Services CBC506

CBC507 - Provision of Services to unrelated parties CBC507

CBC508 - Internal Group Finance CBC508

CBC509 - Regulated Financial Services CBC509

CBC510 - Insurance CBC510

CBC511 - Holding shares or other equity instruments CBC511

CBC512 - Dormant CBC512

CBC513 - Other CBC513
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APPENDIX - FORM 8975 REFERENCE
CODES

Reference Code

CBC601 - Revenues - Unrelated CBC601

CBC602 - Revenues - Related CBC602

CBC603 - Revenues - Total CBC603

CBC604 - Profit or Loss CBC604

CBC605 - Tax Paid CBC605

CBC606 - Tax Accrued CBC606

CBC607 - Capital CBC607

CBC608 - Earnings CBC608

CBC609 - Number of Employees CBC609

CBC610 - Assets CBC610
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